VMT2

Release Notes - 10/16/2019
Add: (Mac only) 64bit build supporting OS X Catalina
Add: (Mac only) Retina Display Support

Release Notes - 11/4/2011
Fixed: Crash when setting node order (case 5845).
Fixed: “Add Fixture” button arrow cut off in Windows 7 (case 6243).
Added: Added setup.exe to install package (case 3099).
Fixed: (Mac only) Support for loading jpg and tiff background images (case 6338).

Release Notes - 11/21/2008
Added the finished manual to the installation

Release Notes - 11/14/2008
Changed: Scripts are now found in a new location:
   Win: Documents and Settings/username/VMT2_Scripts
   Mac: Users/username/VMT2_Scripts

Release Notes - 9/10/2008
Added: Proper handling if more than 26 fixtures associated to same port.
Fixed: No longer crashes choosing New Map with group in clipboard.
Fixed: Node ordering bug introduced by last node ordering fix.

Release Notes - 9/8/2008
Added: Use <alt> w/arrow keys to move selection rectangle. This is confusing visibly, but it works.
Fixed: Bug where node indexes were sometimes lost after saving.

Release Notes - 8/29/2008
Fixed: Panning strangeness under some circumstances.
Fixed: Selecting oddities.
Fixed: Merging maps with conflicting layers & fixtures.
Fixed: Grouping groups when group is only partly selected.
Fixed: Power Supply table sections can be resized.

Release Notes - 8/27/2008
Added: Background Images appear in a submenu.
Added: We now ship with a bunch of predefined Background Images
Fixed: Autoscroll stops properly on Windows
Fixed: Click-launching VMT with a large map on Windows zooms properly.
Fixed: Create group, delete group, undo
Fixed: Select/Deselect All now applies to power supply list when focused.
Fixed: Auto-scroll no longer gets stuck on Windows.

Release Notes - 8/20/2008
Added: Can choose options for displaying background images.
Added: Send Background Image to Lights
Added: Distribute now works with Selected items
Added: Distribute allows user to specify a rectangle
Changed: Added "Zoom" to In, Out, 100% in menus
Fixed: Appending LSM maps corrects LSM coordinates
Fixed: Icon in shortcut is correct now
Fixed: Autoscrolling works properly with both node tools
Fixed: Cursor changes properly for both node tools
Fixed: In Select Nodes can now single click a node to select it
Fixed: Corrected tool tips for Add Supply and Get Info
Fixed: Names in Power Supply list now sort properly with numbers. For example, Name10 now comes after Name2

Release Notes - 8/11/2008
Added: Support for loading LSM maps. Please try it out!
Added: Colors tab to Preferences Dlg.
Added: Cancel button to Preferences Dlg.
Added: Masked and Kinet Version fields to Export to CSV.
Changed: Port Buttons are not shown as modal any more: click to send color to the port.
Changed: Selected Network Interface is now bold in list for easier ID on Win.
Changed: Default name from "Fake Power Supply" to "Virtual Power Supply"
Fixed! Rectangle selections that autoscroll no longer lose their origin.
Fixed: If you click Check For Updates, you'll be notified if none is available.
Fixed: Groups lock and unlock properly now.
Fixed: Windows: Power Supply panel no longer hides on minimize.

Release Notes - 7/30/2008
Added: "Append Map" works! Please test and report any problems.
Added: "Discover Nodes for All Power Supplies" is back for good.
Added: "Select Next Node" and "Select Previous Node" (Edit menu)
	The idea here, from a beta tester, is that you can cycle through the nodes on a fixture with just a keypress. When you get to the last node in an associated fixture, VMT moves on to the fixture on the next port on that power supply if possible, and so on.
Added: Keyboard shortcuts for Select Nodes and Move Nodes.
Added: Tool tips now show keyboard shortcuts
Added: When adding Fake Supplies, default IP address increments to avoid conflicts.
Change: "Deselect All" is now Ctrl-D and "Duplicate" is Ctrl-Shift-D.
Change: "Add New Supplies..." changed to "Add Supply..." to match button.
Fixed: Crash when undoing an add of a fake supply.
Fixed: Now sends delayed Sync after pausing VSE.
Fixed: Typo in power supply info dialog, cap. IP address.
Fixed: Only get magnifying glass cursor with Zoom in, not with zoom out
Fixed: Please send a screen shot of the Real/virtual supply merge dialog. 
Fixed: Can't select clone after using sel. node or move node.
Fixed: Can't create group after selecting fixtures by clicking their supply.
Fixed: Crashes with New Map > Discard Changes.
Fixed: Select tool sometimes won't select a group, move tool does, goes off Grid, etc. App is stressed by moving groups. After moving a group (associated or unassociated) 2 or 3 times, group won't snap, change back to unselected colors, or ungroup.
Fixed: Can't select multiple nodes if I start inside fixture.

Release Notes - 7/23/2008
Changed: Scripts menu is gone. Script Interpreter is under View.
Changed: Windows: Preferences menu item is under Edit.
Changed: VMT Help menu item is gone.
Added: Lock/Unlock to contextual menu.
Fixed: Network Interface bug.
Fixed: Win Preferences dialog freezes with no network.
Fixed: Weirdness with Select tool & groups.
Note: Show Overlapping Nodes has been removed for this release

Release Notes - 7/22/2008
New: No more Node Mode or Fixture Mode
	Just choose the new Node-Specific tools when you need them.
	Feedback on this change is encouraged!
New, Untested: Can specify a Network Interface (in Preferences)
New: Can Lock/Unlock fixtures
New: View/Layers: Added Show All
New: View/Layers: Holding down alt with Show All to Hide All instead
New: View/Layers: Holding down alt when selecting a layer to hide all other layers at the same time
New: Mask/Unmask Nodes have keyboard shortcuts
New: Can Undo/Redo Mask/Unmask Nodes
New: Status line shows VSE pause status changes
Fixed: Crash when loading second large map
Fixed: Arrow keys only affect map when it has focus.
Fixed: Zooms/Moves properly when loading all grouped fixtures
Fixed: Node count doesn't get stuck on 170 when list Refreshed
Fixed: Status no longer reads "Many" for 1 supply with N ports selected
Fixed: Draws grouped associated fixtures properly at low zooms
Fixed: Can add/del nodes to fixtures while inside groups

Release Notes - 7/14/2008
New: Mac version now has a nice disk image.
New: Can now Export a .csv file with all node data.
New: Added "Show Network Interfaces" dialog (Help menu).
New: Added Preferences dialog.
Changed: You can click "off" the power supply list to deselect all supplies.
Fixed: Selection no longer lingers after Power Supply Info dialog.
Fixed: Crash on save bug.

Release Notes - 7/8/2008
New: Map changes color to more clearly indicate when in Node Mode.
New: Filter for Associated or Unassociated power supplies.
New: Right-click Pastes land on the click point.
New: Can load background images of any size.
New: Contextual menus are improved, more situational.
New: Windows app has an icon.
New: "Fixture Library" is now in App Support/App Data folder.
New: "VMT2_Scripts" are now "Scripts" and are in the same folder.
New: Mac app auto-installs Fixture Library at first launch.
New: Windows installer is customized for VMT.
New: Can double-click map file to launch VMT.
Fixed: Can now load jpeg background images on Windows.
Fixed: Rotating oddly-shaped fixtures works now.
Fixed: Distribute works, including with Groups now
Fixed: Can Undo adding nodes

Release Notes - 6/20/2008
New: View Menu: You can hide/show Fixture bounding boxes
New: Can right click to Copy/Paste/Rotate, and more.
New: Added more zoom levels
Fixed: Supplies that go offline now move to the "unconnected" list.
Fixed: Layer Bug when using many layers.
Fixed: Layer Bug when fetching map from VSE.
Fixed: Windows: Alt-S no longer refers to two menus
Fixed: "New Fixture >" is now "Add Fixture >"
Fixed: Some menu items status updating is fixed.

Release Notes - 6/6/2008
Fixed: Set Node Order dialog works now!
Fixed: Close power supply list panel, can't reopen
Fixed: First click gets lost in Edit mode (at least when switching from Add to Delete)
Fixed: Drag a group until the edge-detection kicks in, then move to a normal spot. Undo. Broken.
Fixed: Add Nodes tool, switch to Del Nodes tool, Edit Fixture loses "focus"
Fixed: Scene doesn't draw background image if zoomed out
Fixed: Clone dimensions coordinates vary by zoom
Fixed: Rotate 1x2, 16 times across as a group fails
Fixed: Rotating staggered fixtures causes Port Index badge to get moved
Fixed: Moving with arrow keys doesn't Undo properly
Fixed: Undoing a rotate of a fixture doesn't do update (because nothing *in scene* moved.)
Fixed: PortIndexBadge disappears in NodeMode

Release Notes - 5/29/2008
Note: I made huge changes to the way VMT handles nodes, which should result in a big speed increase for larger maps. You may see some new bugs as a result of this. Please report them! Thanks.
Note: Groups definitely don't work well with Rotate or Undo at the moment. Distribute is broken as well.
New: <shift-arrow-key> moves selected fixtures 10 spaces at a time.
New: Nodes turn transparent when background image is loaded.
Fixed: Last Mac build wouldn't run due to Qt 4.4 conflict.
Changed: While cloning, the dimensions indicator now follows the mouse.
Changed: Grid no longer drawn at low zoom levels
Bug: Set Node Order only works if First Node is the top left corner.

Release Notes - 5/19/2008
New: You can now Remove both real and fake supplies from the list.
New: You can now Filter the power supply list in various ways.
Fixed: Integration with a live VSE is greatly improved. Capture Image and Live Node Moving both work.
Fixed: Assigning more than one fixture to the same output on the same power supply now works properly.

Release Notes - 5/12/2008
New: Quickly zoom in & out with <shift>+<scroll wheel>
Fixed: Nodes are still drawn at very low zoom levels.
Scripting: Advanced users can specify a send order for power supplies.

Release Notes - 5/8/2008
Scripting: You can now send data to supplies on the map even if they have not been discovered.
Note: Zooming is funky right now.

Release Notes - 5/7/2008
New: When loading, map zooms to show loaded map.
New: Zoom Out tool.
New: "New Fixture..." menu item.
Fixed: Scripting allows fine control over packet delay.

Release Notes - 5/6/2008
Fixed: Handles duplicate IPs on live network.
Fixed: Network library identifies more PC accent sizes correctly.

Release Notes - 5/5/2008
New: VMT sends data to supplies even if they're no longer discovered.

Release Notes - 4/30/2008
New: PowerSupply list behavior is vastly improved.
Fixed: Backwards compatibility with VMT1

Release Notes - 4/23/2008
New: When you select a supply in the list, VMT "lights" it, and only it. This allows the user to "arrow" through the list of supplies to see what's where easily.
New: Cycle-click through overlapping fixtures by holding down Alt. Try it!
New: Clone-click behavior corrected; matches ColorPlay.
New: Load a background image (File : Load Background Image...)	Note: Images that are not 1024x768 draw unpredictably for now.
New: Capture a background image from the VSE.
New: Move to Front, Move to Back commands.
New: Resolution guides for common sizes (in View menu).
New: Total node count is now shown at bottom of map.
New: Repetitive map files should be much smaller.
New: Added ability to show/hide Toolbar.
New: You can now select the Add Nodes or Delete Nodes tool and use the first click to specify the desired Fixture for editing.
New: Added an application icon (not on Windows yet)
Changed: Appearance of groups has changed. Opinions?
Changed: Double clicking power supply no longer brings up Info dialog. Was too confusing and irritating.
Changed: Shift-clicking to associate-but-not-increment is gone. Was too confusing and irritating.
Fixed: Many bugs.

Release Notes - 4/16/2008
New: Move to Front, Move to Back commands.
New: Resolution guides for common sizes (in View menu).
New: Total node count is now shown at bottom of map.
New: Built with Qt 4.4rc1. Notify me of any new strangeness.
New: Added visibility control to Toolbar
New: Added an application icon.
Changed: Appearance of groups has changed. Opinions?
Changed: Double clicking power supply no longer brings up Info dialog. Was too confusing and irritating.
Known problems: 
Speed: Faster, but still way too slow.
Toolbar: no longer activates/deactivates tools. Will be fixed.
Clone: clicking behavior doesn't match ColorPlay yet.
Overlapping Fixtures: not indicated for now, can't click through yet.
New Map: doesn't delete fake supplies properly.

Release Notes - 4/3/2008
Big change to associating fixtures. Now faster and easier!
Fixed: In Node Mode, selected nodes on the network turn yellow, not red, to be consistent.
Fixed: Masked nodes show as red on map.
Fixed: Speed should be better. Nowhere near good enough yet, but better.

Release Notes - 3/27/2008
Fixed: Crash caused by memory allocation bug.

Release Notes - 3/5/2008
New: Rotate, Mirror commands (in Edit menu)
New: Layers. (Not editable yet.)
New: For VMT1 maps, VMT2 converts Regions to Layers
New: clicking a supply selects its fixtures
New: clicking a port selects its fixtures
New: supply names in status line now show IP
New: added more app info in VMT2 map files
New: more user preferences are remembered
Fixed: Can’t paste when something is selected
Fixed: Add fake supplies, undo, then associate; they’re still there.
Fixed: New fixture, go to node mode, move node, save map from node mode, load
Fixed: add/delete nodes tools activate properly
Changed: When adding a fixture, it no longer sticks to the mouse. That was just too confusing.

Release Notes - 20080220
Added QtScript framework to distribution.
New: Added "Distribute" to Edit menu. Caution: Does not work with Groups yet.
New: Better info about selection in status bar at bottom of window.
Fixed: Arrow keys move selected items
Fixed: Scrollwheel works properly


Notes on using VMT2:

Associating: Select a power supply, select the associate tool, and click on fixtures in order. If you want to change the port number to associate to, just type a number or use arrow keys to adjust the value.

You can Duplicate, Clone, and Cut/Copy/Paste both fixtures and groups.

Legend

Real world (Please suggest changes!)
		When you select a supply, all of its nodes light up red.
		When you select a port, all of its nodes light up green.
		When you select a fixture, all of its nodes light up yellow.
		In "Node Mode", selected nodes light up yellow.

Map
		Unassociated fixtures are gray.
		Associated fixtures are yellow.
		Masked nodes are red.

Jim Preston
This version was built with Qt 4.7.3

